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Introduction
Thank you for choosing Screening Room, the premier multi-media file viewer and manager.

Screening Room is    was designed to allow you, the user, to quickly scan through large amounts of files, 
classify them, and remove the ones you don't approve.    Screening Room is perfect for Web Masters, 
Sysops, Image collectors or anyone who regularly deals with multimedia files.

Screening Room's internal viewers can handle a wide variety of files such as:

Images ( JPEG, 
GIF, BMP, and 
PNG )

Movies ( AVI, MPG,
and Quicktime)

Digital Audio ( WAV
and AU )

Documents (TXT, 
DOC, WRI, and 
RTF)

MIDI Music HTML Files
Icons Cursors ( ANI and 

CUR )
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How to configure targets
How to customize Screening Room
How to contact Tuesday's Child Software
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How to register
Non-US check registrations for "Screening Room" are handled by Kagi Software. After payment has been
sent to either Kagi or Tuesday's Child Software your registration code will be sent to you by Tuesday's 
Child Software,    this usually happens with 48 hours of payment receipt but may take as long as 4 days. 

Kagi Software: 
Kagi Software 1442-A Walnut Street #392-G8 Berkeley, CA 94079-1405 

How Kagi does business:    
Kagi Software does business via email . We receive postal mail, email, faxes and phone calls, and 
process registration payments. Kagi Software processes software product payments for several hundred 
authors and their programs. We need for you to use the Register program that came with you program 
since most of the payment processing is automated to keep costs low and frees us help you when you 
need it. How we can respond to you: After processing we will send all registered users an email that will 
give you more information about Kagi Software and your program. Email and fax registrations will be sent 
an acknowledgement that we received your registration request. Because of the low percentage that Kagi
Software charges for payment processing we will not respond with a phone call, unless you have an "800"
number or receive collect calls, and we do not send faxes. The only mail that we send is postcard receipts
that have been paid for. Kagi Software is NOT a software publisher and does not ship any product or 
return anything sent on disks. Kagi Software does not provide technical support for any of the other 
programs they handle. 

For technical support: 
Contact the tcsoft@kagi.com here. The email address of the author should also be on the copy of the 
registration form that you send us, so save a copy for yourself. 

How to get help from us if you need it: 
If you do not get a response from your registration request in a reasonable amount of time, email four 
days, faxes six days, postal mail a few weeks, please send the message below to us with the information 
entered. This way we can help you as quickly as possible: *We need this data: Anything that you can 
provide us with would be helpful, such as when and how you sent your payment and any previous email 
messages sent. Please tell us exactly what you want us to do/send to you. 

Your copy of "Screening Room" should come with a small program called "Register", which you use to 
create a personalized registration form to send to Kagi Software. If you do not have the "Register" 
application, you should download a fresh copy of the whole "Screening Room" package because the 
latest version of "Screening Room" includes the Register program. It is vital that you use the registration 
program since payments sent without the registration form it generates can be delayed or lost.

When you launch the Register program, a window appears asking for all the necessary information. If you
have previously registered a program through Kagi Software your personal information will appear, double
check to see that it is right. You must provide a postal address, a US$1.00 extra charge, or an email 
address, so that we can contact you. Please note that we do not reply by FAX. 

Type your name, postal address, and e-mail address in the corresponding boxes at the top of the    
window.    If you have no email address enter "none".    



Special Note: If you do not have an e-mail address, you must check the "Postcard Receipt" box (which 
automatically adds $1 to your charge) at the bottom right of the window. Otherwise, you will not receive 
any reply to your registration. You will be registered, but you will not have the codes. After the initial 
postcard receipt Kagi only replies via email. 

Then, fill in the payment details at the bottom left of the window. Choose your method of payment from 
the pop up menu and complete the relevant information (credit card number, type of currency, etc.) below.
Make checks payable to "Kagi Shareware." Checks must be in US Dollars only. Please write the program 
name on the check as well as your email address, if you have one. See Email, Fax and Postal 
instructions for more detail. 

Note: Your credit card data is scrambled.Although this is not completely secure, we have never had a 
case of credit card fraud. 

Note: Purchase Orders must include payment with the invoice. Please see the Purchase Order 
instructions file. 

Next, indicate the programs you want to register in the middle of the window. Type the number of copies 
you want to register into the Single User box. In most cases you should just type "1". Do not type the 
purchase price into this box since the "Register" application computes the fee for you. The "Site" and 
"World-Wide" check boxes are intended for companies or organizations that want a license to use the 
software on all their machines. Double check this before you send in the form as you may be charged 
significantly more that you expect if you make a mistake. 

If you feel that the program is worth more than the registration fee, you can add an optional bonus in the    
"Bonus US$" box.

Note: If the "Register" application lists more than three programs, and you can use the scroll bar at the 
right of the window to see the others. Once you have filled in all this required information, the Register 
program displays the total amount at the bottom right of the window. Double check the total! Choose one 
of these three items, see Email, Fax and Postal instructions for more detail.

Print... prints a hard copy of the registration form, which you can mail to Kagi Software with your payment 
to the address shown on the form. 

Copy... puts a copy of the registration form on your clipboard for you to paste into an e-mail message to 
send to Kagi Software. This method works only with credit cards and First Virtual since it is not yet 
possible to email cash or checks. 

Save... saves a copy of the registration to your hard disk as a SimpleText document for you to print out or 
e-mail later. 

Double check your registration request to see that all the information is correct, if not, correct it using the 
Register program. Do not edit the output produced by the Register program. The Kagi email and postal 



mail addresses are given on the registration form and above. Save a copy for yourself. We suggest 
printing it out. Note the author's email address. 

Kagi Software registration, how it works: 
After you register, Kagi Software automatically sends you an e-mail reply titled "Thanks for your 
registration". You should print and save this message as your receipt. You will also need it if you reinstall 
the program for any reason. If you checked the "Postcard Receipt" box in the Register program, Kagi will 
send you a postcard with this information. Again, if you do not have an e-mail address, you must request 
a "Postcard Receipt" since otherwise you will not receive any reply. It can take Kagi up to a week to 
process a registration from the date they receive it (please make sure to factor in the delivery time if you 
use postal mail). If you do not receive the "Thanks for your registration" e-mail message, contact Kagi at 
or the postal address given on the registration form to ask about the status of your registration. See *We 
need this data: above. Keep in mind that some registrations can get lost in the mail on the way to Kagi. 
Please make sure to seal the envelope and write your email address on the check. Also, sometimes the 
e-mail reply gets lost as well (America Online is particularly unreliable when it comes to receiving e-mail 
from the internet). If you do not receive an email confirmation of your payment, contact us with the "*We 
need this data:" from above and ask what happened.



Defining Targets
Screening Room is more than just a file viewer,    it was designed to allow you to easily sort and 
categorize your files as well.    To allow you to manage your files Screening Room allows you to set up 
"targets" which point to different directories on your hard drive as well as "target sets" which let you group 
your targets.    

Through the targets page of the preference dialog you can add or delete targets.

The top combo box allows you to select which target set you wish to work with. 

Clicking on the "Add Set" button will bring up a dialog asking you for the name of the new set, and will 
then ad it to your list of target sets.

Clicking the "Delete Set" button will remove the target set currently listed from the list as well as remove 
all of the targets in the set.

The list box below the set combo contains the list of targets in the currently highlited set.    Clicking the 
"Add Target" button will bring up a dialog allowing you to enter the name of the target as well as the path it
should point to.    A browse button is included on this dialog to help you locate the directory to point it at.    
Pressing the "Delete Target" button will delete the currently highlited target in the list.



Setting Preferences
The "General" tab
The "Targets" tab
The "Registration" tab



The General Tab
The genral preferences page allows you to set options such as the default starting directory and the 
default state of the image AutoFit feature.

When Screening Room starts up the explorer window will display the contents of the default startup 
directory unless a directory / filename has been entered on the command line.    Pressing the option 
button labeled "Start with last accessed" will cause Screening Room to startup in the directory that the 
explorer window was showing the last time you shut down Screening Room.

The startup state of the image AutoFit feature can be tailored to your needs here as well.    You can set 
the startup mode to be On, Off or the last value you selected while running Screening Room.



The Registration Tab
After you have received your registration code from Tuesday's Child Software you can enter it here.

Enter the name you used to regiter the application with as well as the special code you received from 
Tuesday's Child Software.    If you entereed the correct code and name the shareware reminders will now 
be gone.

Pressing the button labeled "Register" will launch an application that will allow you to fill out an order and 
either print it or copy it to the clipboard for you to send it via E-Mail.

See also: How to register



Contacting Us
Tuesday's Child Software can be contact via E-Mail at: tcsoft@kagi.com

For prompt handling of you mail please use the following keywords in the subject line of your message:

· SROOM Bug - To report a bug.
· SROOM Comment - For comments and suggestions.
· SROOM Support    - For support issues.
· SROOM Misc - For other issues and questions.

We can also be reached by ground mail at:

Tuesday's Child Software
7822 County Road 158
East Liberty, OH 43319

USA



Menus
The File menu has the following options:

· Preferences - Allows you to configure the application.
· Exit - Exits the application.

The View menu allows you to hide or show the explorer window and the target window.

The Help menu contains the following options:

· Contents - Displays this file.
· Tuesday's Child on the Web - Launches a browser to our home page.
· About - Displays the applications version information and copyright notice.



Keyboard
Pressing the "Escape" key will cause Screening Room to minimize itself to a tray icon.    Double click on 
this icon to restore the app.

Pressing the "Delete" key will delete the currently highlited file in the file list.



Windows
The main window
The explorer window
The targets window



The Main Window

This window provides you with a tool bar to perform various functions as well as a status bar that tells you
the current number of files in the file list as well as something about the file currently being viewed.

The tool bar buttons (From left to right) perform the following actions:

· Bring up the preferences dialog so that you can set preferences, create target sets and enter your 
registration code.
· Return you to your starting directory.
· Toggle the file transfer mode between move and copy.    Use the copy mode when working with 
read only material such as    CD-ROMs
· Refresh the list of files in the explorer window.    This is useful if you copy files into or out of the 
directory using another program.
· Toggle the AutoSize state.    when this button is pressed images will be stretched or shrunk to fit 
within the viewing window. This can effect the image quality.
· Display a dialog that will allow you to delete multiple files from the currently displayed directory 
using a file mask.



The Explorer Window

From this window you can select the file you wish to view.    This window works in the same way as the 
"File Open" dialogs common to many Windows applications.

The combo box on the top enables you to change the type of files displayed in the file list.    

The next combo allows you to you to select which drive you wish to browse.    

After you have selected a drive, the tree list will fill with the directories on that drive. 

Double clicking on a directory will cause the file list to fill with the contents on that directory.    If you have a



large number of files in the directory this may take a few moments.    Selecting a file in this list will cause 
the file to be displayed.



The Target Window

This window is used to manage your files.    From here you can delete files, as well as move and copy 
files to a target.

The combo box at the top is used for changing between your target sets.    Changing the current target set
will cause the target buttons below to change.

The large button below will allow you to delete the file currently hi-lighted in the explorer window.    A right-
click on this button will bring up a dialog which allows you to delete multiple files based on a file mask 
( i.e. "foo*.bak" ).

Depending on the targets you have defined there will be up to ten target buttons below the delete button.   
Pressing one of the buttons will cause the file selected to be either moved or copied to the directory for 
that target.

See also: Defining Targets
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